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Abstract

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking between Cogeco and an enterprise solution using Avaya IP Office Release 9.0 and
Avaya Session Border Controller for Enterprise 6.2.

The Cogeco SIP Trunking Service provides PSTN access via a SIP trunk between the
enterprise and the Cogeco network as an alternative to legacy analog or digital trunks. This
approach generally results in lower cost for the enterprise. Cogeco is a member of the Avaya
DevConnect Service Provider program.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describes the steps to configure Session Initiation Protocol (SIP)
Trunking between Cogeco and an enterprise solution using Avaya IP Office Release 9.0 and
Avaya Session Border Controller for Enterprise 6.2.

The Cogeco SIP Trunking Service referenced within these Application Notes is positioned for
customers that have an IP-PBX or IP-based network equipment with SIP functionality, but need
a form of IP transport and local services to complete their solution.

The Cogeco SIP Trunking Service will enable delivery of origination and termination of local,
long-distance and toll-free traffic across a single broadband connection. A SIP signaling
interface will be enabled to the Customer Premises Equipment (CPE).

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site to the Cogeco SIP Trunking
Service via the public Internet and exercise the features and functionality listed in Section 2.1.
The simulated enterprise site was comprised of Avaya IP Office, Avaya Session Border
Controller for Enterprise (Avaya SBCE) and various Avaya endpoints listed in Section 4.

The Cogeco SIP Trunking Service passed compliance testing with observations/limitations
described in Section 2.2.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

e Registration of the SIP line with the service provider

e Sending/receiving SIP OPTIONS queries to/from the service provider

e Incoming PSTN calls (via the Cogeco SIP trunk) to SIP and H.323 telephones at the
enterprise

e Qutgoing PSTN calls (via the Cogeco SIP trunk) from SIP and H.323 telephones at the
enterprise

e Inbound and outbound PSTN calls to/from soft clients (Avaya IP Office Video Softphone
and Avaya Flare® Experience for Windows)
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Various call types including: local (10 digits), long distance (1 + 10 digits), outbound
toll-free, international (011 + country code + number), operator, operator-assisted (0 + 10
digits) and local directory assistance (411)

Codec G.711MU

T.38 Fax

Caller ID presentation and Caller ID restriction

DTMF transmission using RFC 2833

Response to incomplete call attempts and trunk errors

Voicemail navigation using DTMF input for inbound and outbound calls

Voicemail message waiting indicator (MW1)

User features such as hold and resume, internal call forwarding, transfer, and conference
Off-net call forwarding and twinning

REFER message for call redirection

Direct media

Remote worker

Emergency calls (911) and inbound toll-free calls are supported but were not tested as part of
the compliance test.

The following item is not supported:

G.729 codec

In addition, the Cogeco SIP Trunking Service requires the following behavior in the SIP
messaging:

Eleven (1+10) digits must be sent in the Request-URI and To headers of an outbound SIP
INVITE message for long distance calls and 10 digits must be sent for local calls.
International calls are dialed with 011 as the international dialing prefix for North
America followed by the country code and then the number. See related routing in
Sections 5.5 and 5.6.

As a best practice, the Uniform Resource Identifier (URI) of the P-Asserted-Identity
(PAI) header in an outbound SIP message should contain the pilot number as the host and
the Cogeco provided domain as the domain (instead of the local IP address). See
configuration in Sections 5.4.4, and 5.4.6.

2.2. Test Results

Interoperability testing of the Cogeco SIP Trunking Service was completed with successful
results for all test cases with the exception of the observations/limitations described below.

“Ring No Answer” call from analog PSTN phone: If an inbound call from an analog
PSTN phone to an enterprise extension is allowed to “ring no answer” for roughly 3
minutes (until the timer expires) then both parties should be disconnected. However, it
was observed that the enterprise destination was disconnected but the PSTN caller
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remained connected and continued to hear ringing. Troubleshooting indicated that this
most likely was an issue with an upstream provider beyond Cogeco’s network. In
general, this issue would not impact a customer since it would be rare that calls are
allowed to ring for 3 minutes. In addition, the PSTN caller can hang up the line to clear
the call. If it should occur at a customer site, Cogeco would work with all upstream
providers to resolve the issue.

e No matching codec condition returns a 480 response: In the case where the enterprise
is misconfigured so that it does not use any codec shared by Cogeco, an outbound call
from the enterprise will result in Cogeco returning a “480 Temporarily Unavailable”
response instead of a “488 Not Acceptable Here”. This behavior has no impact on the
caller. The caller still hears an error treatment.

e Operator-assisted calls fail: Operator-assisted calls (0 + 10 digits) placed from the
enterprise do not connect. The caller hears an error announcement. This issue is under
investigation by Cogeco.

e Call Fowarding and EC500: For inbound PSTN calls that were forwarded back to the
PSTN or ring to an EC500 (enterprise mobility) PSTN endpoint, the PSTN destination
phone display (if equipped) showed the forwarding party/EC500 host instead of the
original PSTN caller. A SIP header manipulation was added on the Avaya SBCE to
correct the phone display to show the original PSTN caller. See Section 6.6.1 for details.

e T.38 Fax — Network Coverage: Not all media gateways in the Cogeco network support
T.38 fax. Avaya IP Office supports fallback to G.711 pass-through fax from T.38 fax if
configured on the SIP Line form (See Section 5.4.5). This is the recommended setting if
all gateways in the service provider network do not support T.38 fax.

e Conferencing with IP Office Video Softphone: IP Office Video Softphone calls a
PSTN phone or internal extension and then conferences in another internal extension.
This call scenario intermittently fails to conference all parties. This is not related to the
interoperability test and is under investigation by Avaya.

2.3. Support

For technical support on the Cogeco SIP Trunking Service, use the contact information for
business customers in a specific geographic region at www.cogeco.com.

3. Reference Configuration

Figure 1 illustrates the sample configuration used for the DevConnect compliance testing. The
sample configuration shows an enterprise site connected to the Cogeco SIP Trunking Service.

Located at the edge of the enterprise is the Avaya SBCE. It has a public side that connects to the
external network and a private side that connects to the enterprise network. All SIP and RTP
traffic entering or leaving the enterprise flows through the Avaya SBCE. In this way, the Avaya
SBCE can protect the enterprise against any SIP-based attacks. The Avaya SBCE provides
network address translation at both the IP and SIP layers.

The enterprise site contains an Avaya IP Office 500 V2 with various endpoints and a Windows
2003 Server running both Avaya IP Office Manager to configure the Avaya IP Office and Avaya
Preferred Edition for voicemail (also known as VVoiceMail Pro).
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Figure 1: Avaya Interoperability Test Lab Configuration

For security purposes, any public IP addresses or PSTN routable phone numbers used in the
compliance test are not shown in these Application Notes. Instead, public IP addresses have
been replaced with private addresses and all phone numbers have been replaced with numbers
that cannot be routed over the PSTN.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to send digits
across the SIP trunk to Cogeco. The short code of 9 is stripped off by Avaya IP Office and the
remaining digits were sent unaltered to Cogeco. Cogeco requires 11 digits (1+10 digits) be sent
in the Request URI header for long distance calls and 10 digits for local calls. On inbound calls,
Cogeco will send 10 digits in the Request-URI.
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Avaya Telephony Components

Equipment

Software

Avaya IP Office 500 v2

9.0 SP1 (845)

Avaya IP Office Manager

9.0 SP1 (845)

Avaya IP Office Preferred Edition 9.0 SP1 (53)
(Voicemail)
Avaya Session Border Controller for 6.2.1.Q07

Enterprise running on a Portwell CAD-0208
server

Avaya 1140E IP Deskphone (SIP)

4.3 SP2 (04.03.18.00)

Avaya 1608 IP Deskphone (H.323) running 1.3 SP4 (1.343A)
Avaya one-X® Deskphone Value Edition
Avaya 9641G IP Deskphone (H.323) running 6.3 (6.3037)

Avaya one-X® Deskphone Edition

Avaya IP Office Video Softphone (SIP)

3.2.3.48 (67009)

Avaya Flare® Experience for Windows 1.1.4.23
Cogeco Components
Equipment Software
Acme Packet 4500 Session Border Controller SCX6.1.0 MR-10 Patch 1 (Build 985)
BroadSoft BroadWorks Softswitch / Core 18

Telephony Application Server

Testing was performed with Avaya IP Office 500 V2, but this testing also applies to Avaya IP
Office Server Edition running the same software release. Note that Avaya IP Office Server
Edition requires an Expansion IP Office 500 V2 R9 to support analog or digital endpoints or

trunks.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
Avaya IP Office Manager PC, select Start - Programs - IP Office - Manager to launch the
application. A screen that includes the following in the center may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Oipen Configuration from System

Fead a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the
configuration may be alternatively opened by navigating to File > Open Configuration at the
top of the Avaya IP Office Manager window. Select the proper Avaya IP Office system from the
pop-up window and log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group Pane has been omitted, its content is shown as submenus in the Navigation
pane. These panes (Navigation, Group and Details) will be referenced throughout the Avaya IP
Office configuration. All licensing and feature configuration that is not directly related to the
interface with the service provider (such as twinning and IP Office Video Softphone support) is
assumed to already be in place.

In the sample configuration, Atlantic City was used as the system name. All navigation
described in the following sections (e.g., License = SIP Trunk Channels) appears as submenus
underneath the system name Atlantic City in the Navigation Pane.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require Avaya IP Office to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,

contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in
the Navigation pane. Confirm a valid license with sufficient Instances (trunk channels) in the

Details pane.

I -

#- R BOOTR (4)
-7 Operator (3)
=55 Atlantic City

License | Remate Server

License Mode  License Mormal

£+ System (1) PLDS Host [D
+-F9 Line (16)
- Control Unik (3) Feature License Key Instances Status Exzpiry Date
# - Extension (25) IPS00 Yaice Nebworking Channels 4 Yalid Mever
@i User (27) WM Channel Migration 255 Walid Kever
i Group (1) [LSIP Trunk Channels 255 ‘alid Hever ]
+- 8% Short Code (B4 WP IP Extensions 255 Obsolete Mewver
@ Service (0} IPS00 Universal PRI {Additional chan. .. 255 walid ever
- aly RAS (1) RAS LR Support {Rapid Response) 55 Walid hever
. IP Office Dealer Support - Standard E. .. 255 Walid Mewver
+ e Iwncorslnf CDaI\ Raute (26 1P Office Dealer Support: - Profession. .. 255 walid ever
@ .an ort (0) 1P Office Distributor Support - Standa. .. 55 Walid hever
"*_ﬁ- Directory (0 1P OFfice Distributor Support - Profes... 255 Walid Mever
£771 Time: Profile (1) UM tiieh Services 255 walid Mever
- Firewall Profile (1) CCR SUP 255 Walid Hever
+- [l TF Route (4) Customer Service Agent 255 Yalid Mever
& Account Code (0) CCR, Designer 255 walid ever
. CCR CCCUPG 255 walid Mever
L 7
.‘; Tlcensn‘a (D ) 1600 Series Phones 285 Walid Mever
;ﬂ unne (0) Third Party AP 255 Walid Mever
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To view the physical hardware comprising Avaya IP Office, expand the components under the
Control Unit in the Navigation pane. In the sample configuration, the second component listed
is a Combination Card. This module has 6 digital stations ports, two analog extension ports, 4
analog trunk ports and 10 VCM channels. The VCM is a Voice Compression Module supporting
VoIP codecs. An Avaya IP Office hardware configuration with a VCM component is necessary

to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the IP 500 V2.

IP Offices

K BooTP (4
1 Operator (3)
(=% Atlankic Ciky

w2y Swshem (1)

7 Line (16)

[=) = Conkral Unit §3)

2 COMBOGZ10JATME
o 3 DIGSTASIATMS
A8 Extension (25)
i userizm
ﬂ Group (1)
BX Shork Code (64)
@ Service (0]

Unik

Device Mumbey

Lnit Type

Wersian

Setial Murnber

Unit IP Address
Inkerconneck Mumnber

Module Mumber

IP 500 V2 =

1
IF 00 V2

9.0,100,545

10,32.125.25
1]

Control Unit
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5.2. System

Configure the necessary system settings.

5.2.1. System — LAN1 Tab

In the sample configuration, the Avaya IP Office LAN port was used to connect to the enterprise
network. The LANL1 settings correspond to the LAN port on the Avaya IP Office 500 V2. To
access the LANL1 settings, first navigate to System = <Name>, where <Name> is the system
name assigned to the Avaya IP Office. In the case of the compliance test, the system name is
Atlantic City. Next, navigate to the LAN1 - LAN Settings tab in the Details Pane. Set the IP
Address field to the IP address assigned to the Avaya IP Office LAN port. Set the IP Mask
field to the mask used on the enterprise network. All other parameters should be set according to

customer requirements.

IP Offices

- & BOOTP (4)

+-{w Operator (3)

==y Atlankic City

=%y Swskem (1)
w2y Atlantic City

17 Line (16)

w» Conkrol Unit {33
Al Extension (25)
a User (277
+- 3 Group (1)
+-- @ Short Code (64)

@ Service (00

il RAS (1)

+ @ Incoming Call Route [36)
!Eﬂ WanPort (0)
@@ Directory (07
IfT" Time Profile (0}

- E- B

System | LAMD | LaMNZ | DMS
LaMN Setkings | YaoIP

IP Address

IP Mask

Primary Trans, IP Address

RIP Mode

Mumber OF DHCP IP Addresses 2000 (3

DHCF Mode

() server (O Client ) Dialn (%) Disablad

Atlantic City

Voicemail | Telephorw || Directory Services | Syskem Events

Metwiork Topalagy

10 32 128 25

295 . 255 . 255 0

0 0 0 o
MNone
[] Enable MaT

FY
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On the VoIP tab in the Details Pane configure the following parameters:

e Check the SIP Trunks Enable box to enable the configuration of SIP trunks.

e The RTP Port Number Range can be customized to a specific range of receive ports for
the RTP media. Based on this setting, Avaya IP Office would request RTP media be sent
to a UDP port in the configurable range for calls using LAN1.

e Inthe RTP Keepalives section, set the Scope to RTP. Set the periodic timeout to 30 and
the Initial Keepalives parameter to Enabled. These settings will cause Avaya IP Office
to send a RTP keepalive packet starting at the time of initial connection and every 30
seconds thereafter if no other RTP traffic is present. This facilitates the flow of media in
cases where each end of the connection is waiting to see media from the other, as well as
helping to keep firewall ports open for the duration of the call.

E Atlantic City £ | %X | v =]

System | LAML | LaNz | DMS || Yoicemai | Telephony | Directory Services | System Events | SMTP || SMDR | Twinning | ¥CM | CCR || Codecs

LaM Settings | ¥oIP | pebwork Topology

P
H323 Gatekeeper Enable
[] Autg-create Extn Aubo-create User [] H323 Remate Extn Enable

SIP Trunks Enable

SIP Registrar Enable

[] auto-create ExtnfUser [1 1P Remote Extn Enable
Darnain Mame
UDF LUDP Port  |S060 - Remote LIDP Fort
Laver 4 Praktacal TCP TCP Part  (SOE0 E Remaoke TCP Park
[]TLs TLS Park 5061 - Remote TLS Port
Challenge Expiry Time (secs) 10 -

RTP

Part Muriber Range

Mirirnum 49152 3 Maxirnum 53246

4

Port Number Range (MAT)

Minirnur 49152 3 Maczimurn S3zds %

Enable RTCP Monitaring on Park 5005

Keepalives
Scope RTP “ | Periodic bmeout 30
Initial keepalives Enabled w
w
< b3
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Scroll down the same page to the DiffServ section.

e Auvaya IP Office can also be configured to mark the Differentiated Services Code Point
(DSCP) in the IP Header with specific values to support Quality of Services policies for
both signaling and media. The DSCP field is the value used for media and the SIG
DSCP is the value used for signaling. The specific values used for the compliance test
are shown in the example below and are also the default values. For a customer
installation, if the default values are not sufficient, appropriate values will be provided by
the customer.

e All other parameters should be set according to customer requirements.

E Atlantic City & | X | w]=<|

Swstem [ LAML | LANZ || DNS || Woicemail | Telephony | Direckory Services || System Events | SMTP | SMDR | Twinning | WCM | CCR | Codecs
L&k Settings | ¥0oIP | Network Topology
Keepalives 2
Scope RTF * | Periodic timeout 30
Initial keepalives Enabled w
DiffSery Settings
BS | DICP(Hex) BS || Wideo DSCP(Hex) FC 3| DSCPMaski(Hex) 88 % | 51GD3CP (Hex)
46 2| DscP 46 % Video DSCP 63 % | DSCP Mask 3 % sleDscp
DHCP Settings
Primary Site Specific Option Mumber (SS0M) 176 £
Secondary Site Specific Cption Mumber (S50M) 242 £
WLAMN Mot Present b
1100 Yoice YLAM Site Specific Option Mumber (S50M)  [£232 -
1100 Yoice YLAN IDs
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. The Avaya SBCE will perform network address translation of SIP traffic
but it is not necessary for Avaya IP Office to have any knowledge of this translation.
Thus, the parameter was set to Open Internet.

e Set Binding Refresh Time (seconds) to 30. This value is used to determine the
frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider.

e Set the Public Port to the port on which Avaya IP Office will listen.

e All other parameters should be set according to customer requirements.

= Atlantic City -

Syskem | LAML | LANZ | DMS || Yoicemail | Telephony | Direckory Services || Swstem Events | SMTP || SMDR | Twinning ||
LaM Setkings | woIP | Metwork Topolagy

Metwark Topology Discovery

STUM Server Address 10,90, 168,13 STUN Port 3475 =
Firewall/MAT Tvpe Cpen Internek W
Binding Refresh Time (seconds) 30 £
Public IP Address n n n n Zancel
Public Port
1DP 5060 E-
TCP ]
LS o i

|:| Run STUM on startup
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5.2.2. System - Telephony Tab

To access the System Telephony settings, navigate to the Telephony = Telephony tab in the
Details Pane. Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding
and call transfer to the PSTN. If for security reasons incoming calls should not be allowed to
transfer back to the PSTN then leave this setting checked.

E Atlantic City &l | %X [ wl=<|

Swebern | LAN1 || LANZ || DMS Yoicemail | Telephary Directory Services || Syskem Events || SMTP || SMDR. || Twinning || ViCM CCR Codecs
Telephony | park & Page || Tones & Music | Ring Tones | M Call Log || TLI
A
Analogue Extensions Companding Law
Suwitch Line
Default Sukside Call Sequence Marmal w
Diefault Inside Call Sequence Ring Type 1 w @® U-Law @ U-Law Line
Default Ring Back Sequence Ring Type 2 A
? . LAk (:) B-Law O A-Law Line
Restrict Analogue Extension Ringer Yoltage FI
Dial Delay Time (secs) 4 S [ Dss status
Dial Delay Court 0 £ ailss sl
Defaulk Mo Answer Time (secs) 25 B et 257 (R
W
Hold Timeaut (secs) o £ SNE ¢3aE s (s
Park Ti b (ses) 0 A [ 1nhibit ff-Switch Forward Transfer
atk Timeout {secs =
Ring Delay (secs) = = [] Restrict Metwork Interconnect
ing Delay (secs -
- [] orop External Only Impromptu Conference
Call Priority Prometion Time {secs)  |[Disabled -
[ wisually Differantiate External Call
Defaulk Currency usm w
Unsupervised Analog Trunk Discannect Handling
F d Anal k dl
Defaulk Mame Priority Favor Trunk. W
High Quality Conferencing
Media Connection Preserwvation Disabled A
tic
[ strict 515
Digital/Analogue Auto Create User
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5.2.3. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details
Pane as shown in the following screen. The Send original calling party information for
Mobile Twinning box is not checked in the sample configuration, and the Calling party
information for Mobile Twinning is left blank. Click the OK button at the bottom of the page
(not shown).

Atlantic City

Swskermn | LAM1 | LANZ | DMNS Yoicemail | Telephony | Direckory Services || Swstem Events | SMTP | SMDR. | Twinning | 4y

[] send original calling party information For Mabile Twinning

Zalling party information For
Mabile Twinning

5.3. IP Route

Navigate to IP Route = 0.0.0.0 in the left Navigation Pane if a default route already exists.
Otherwise, to create the default route, right-click on IP Route and select New. Create/verify a
default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.

e Set Gateway IP Address to the IP address of the default router on the network where
Avaya IP Office is connected.

e Set Destination to LAN1 from the drop-down list.

Click the OK button at the bottom of the page (nhot shown).

IP Offices B 0.0.00 ek B X[vl<|>

K BOOTR (4) IF Route
i/ Operatar (3)
(=% Atlantic City [P Address b0 0.0
=57 System (1) IP Mask o0 .0 .0
sy Atlantic City
4 Line (16) Gakeway IP Address 10 32 128 . 254
= Control Unit {3} o
& Extension (25) Destinakion LAaM1 b
§ User (27 Metric o S
ﬁ Group (1)
B Short Code (64) [ Proxy ARP
@ Service (0)
ol RAS (1)
@ Incoming Call Route (36)
@ \WanPort (0)

s Directory (0)

f'.“ Time Profile {0)
@ Firewall Profile (1)
=il IP Route (4)

EB o000
=
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5.4. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the Cogeco
SIP Trunking Service. The recommended method for configuring a SIP Line is to use the
template associated with these Application Notes. The template is an .xml file that can be used
by IP Office Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP
Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.4.2 — 5.4.6.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required

To create a SIP Line manually, right-click Line in the Navigation Pane and select New - SIP
Line; then, follow the steps outlined in Sections 5.4.2 - 5.4.6.
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5.4.1. SIP Line From Template
1. Copy the template file to the computer where IP Office Manager is installed. Rename the

template file to US_Cogeco_SIPTrunk.xml. The file name is important in locating the
proper template file in Step 5.

Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. Inthe IP Office Manager Preferences window that
appears, select the Visual Preferences tab. Verify that the box is checked next to Enable
Template Options. Click OK.

£ 1P Office Manager, Preferences

Preferences || Directories | Discovery | Yisual Preferences | Security || validation

Iron Size | Small w
Multiline Tabs
Enable Template Options

o [ o [ com |[ = |

Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager. This action will copy the template file into the IP
Office template directory and make the template available in the IP Office Manager pull-
down menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

™ Avaya IP Office Manager Atlantic City

File  Edit  ‘Wiew | Tools | Help

: 0 | 3 Extension Renumber. .,
: ablantic City Line Renumber. ..
Conneckt Ta...,
IP Office
Export k
R BoOTP (4) SCM Service User Management
i+ Operator (3)
[=)--*=y Aklankic Ciky Busy on Held Yalidation
=) Sysker (1)
17 Line (16) M3 Configuration
<2y Conkral Uik
A8y Exkension (3 I t Termplates in M
a User (27) mport Templates in Manager

——

P :

In the pop-up window (not shown) that appears, select the directory where the template
file was copied in Step 1. After the import is complete, a final import status pop-up
window (not shown) will appear stating success or failure. Click OK (not shown) to
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continue. If preferred, this step may be skipped if the template file is copied directly to
the IP Office template directory.

4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane,
then navigate to New = New SIP Trunk From Template.

IP Offices Analogue Trunk -Line 1
‘F‘ BOOTP (4] Lire: Settings |.0.nalngue Options
¢ Operator (3)
=5 Atlant] —.
-y 5J| 1] Mew ’ | H323 Line
E - ‘_"‘1 Generate Analogue Trunk Template IF DECT Line
& E 7f Copy Settings From Template SIF Line
) 5M Line |
i U b o Chrl+ |
e SIF DECT Line
Bx sH=a Copy ChrlC
@ o ol Mews SIP Trunk From Template
=4
“g"m?(' Delet Chrl+Del =
e In elete rl+Del
B wl o) validate :I
a4 Di . :I
T
@ Fi Mew From Template (Binary)
o B TO Dieaibs FAY i 1 1

5. In the subsequent Template Type Selection pop-up window, select United States from
the Country pull-down menu and select Cogeco from the Service Provider pull-down
menu as shown below. These values correspond to parts of the file name
(US_Cogeco_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to finish
creating the trunk.

r — —. -‘
™ Template Type Selection ['L”E”g|
Locale
Country | [Jnited States W |

Service Provider | + | [] Display &I

[ Create new SIP Tunk, ] [ Cancel ]

6. Once the SIP Line is created, verify the configuration of the SIP Line with the
configuration shown in Sections 5.4.2 — 5.4.6.
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5.4.2. SIP Line — SIP Line Tab
On the SIP Line tab in the Details Pane, configure or verify the parameters as shown below.

e Set ITSP Domain Name to the domain provided by Cogeco.

e Set Send Caller ID to Diversion Header. With this setting and the related configuration
in Section 5.2.3, Avaya IP Office will include the Diversion Header for calls that are
directed via Mobile Twinning out the SIP Line to Cogeco. It will also include the
Diversion Header for calls that are call forwarded out the SIP Line.

e Cogeco supports REFER. Thus, REFER Support may be checked or unchecked based
on customer need. If checked, then both Incoming and Outgoing must be set to Always.
This solution was tested both with REFER and without. The screenshot below shows the
settings if REFER is not used.

e Check the In Service box. This makes the trunk available to incoming and outgoing
calls.

e Check the Check OOS box. Avaya IP Office will use the SIP OPTIONS method to
periodically check the SIP Line. The time between SIP OPTIONS sent by Avaya IP
Office will use the Binding Refresh Time for LAN1, as shown in Section 5.2.1.

e Default values may be used for all other parameters.

IP Offices B SIP Line - Line 23 ek -8 X vl<]>
#- R BOOTP (4) SIF Ling |Transport| SIP URI| WoIP || T38 Fax| SIP Credentials
#-{ Operator (3)
=% Atlantic City Lirne Mumber 23 =
=% System (1)
=29 Atlantic City ITSP Domain Mame best. cogecodata.com In Service
B Line (16) LRI T
<2 Control Unik (31 ¥pe s h’
+- 4y Extension (25) )
Prefi Check 0035 v
e : User (27) = =
+ ’ﬁ Group (1} Mational Prefix a Call Routing Method Request URL w
+--@% Short Code (64) e R
N FIQInator number Far
@ Service (1) Country Code Forwarded and twinning calls
ol RAS (1)
1] e Incoming Call Route (36) International Prefix i} Marne Prioriky System Default L
Eﬂ wWanPort {0}
@ Directory (0} Send Caller 1D Diversion Header b4 Caller 1D From From header [
1) Time Profile (0) Association Method By Source [P address A4 Send Fram In Clear O
+- () Firewall Profile (1)
=l IF Route (4) User-Agent and Server
Headers
@ Account Code (0)
= License (77) Service Busy Response 436 - Busy Here A
% Tunnel {0}
+ § 3 User Rights (2) Action on CAC Location Limit | Allow Voicemail W
+ - BRS (3
REFER. i 3
# RAS Location Request (0) O L
i Location (00
Method For Session Refresh Ak v
Session Timer {seconds) ©On Demand E
Media Connection Preservation | Disabled v
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5.4.3. SIP Line - Transport Tab
Select the Transport tab. Set or verify the parameters as shown below.

e Set ITSP Proxy Address to the IP address of the internal signaling interface of the
Avaya SBCE.

e Set Layer 4 Protocol to UDP.

e Set Use Network Topology Info to the network port used by the SIP line to access the
far-end and configured in Section 5.2.1.

e Set the Send Port to 5060.

e Default values may be used for all other parameters.

=] SIP Line - Line 23 ek - X[ vl=<]>

SIP Line| Transport |STP URT|WoIP || T35 Fax| SIP Credentials

ITSP Prowy Address  [10.32.128.20

Metwork Configuration

Layer 4 Prokocal oP L Send Port (5060 -
IJse Metwork Topology Info | LAMN 1 w
Explicit DNS Serveris) 0 1] 0 a 0 1] 0 1]

Calls Route via Registrar

Separate Reqistrar
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5.4.4. SIP Line - SIP URI Tab

A SIP URI entry must be created to match each incoming number that Avaya IP Office will
accept on this line. Select the SIP URI tab, then click the Add button and the New Channel
area will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at
the top, and click the Edit button. In the example screen below, a new entry is created. The
entry was created with the parameters shown below:

e Set Local URI, Contact, and Display Name to Use Internal Data. This setting allows
calls on this line that have a SIP URI that matches the number set in the SIP tab of any
user as shown in Section 5.7.

e Set PAI to Use Credentials User Name. The Credentials User Name is set to the pilot
number assigned to the enterprise by Cogeco as shown in Section 5.4.6. Cogeco
recommends using the pilot number in the P-Asserted-ldentity (PAI) header.

e For Registration, select the entry showing the pilot number from the pull-down menu.

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line in Section 5.8.1. Similarly, associate the line to an outgoing line
group using the Outgoing Group field. The outgoing line group number is used in
defining ARS entries for routing outbound traffic to this line in Section 5.6. For the
compliance test, a new incoming and outgoing group 23 was defined that only contained
this line (line 23).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

Click OK.
Ei SIP Line - Line 23
SIP Line | Transpork| SIPURT ol || T38 Fax| SIP Credentials
Channel | Groups Wia  Local URI | Contact  Display Mame | PAI add...
Remove
Edit. ..
Mew Charinel
Via 10,32,128.25
Local LRI Use Internal Data w
Contack Use Internal Data v
Display Mame Use Internal Data w
PAL Ise Credentisls User Mame w
Reqistration 119055550000 b
Incoming Group 23
Cukgoing Group 23
Max Calls per Channel 10 |
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Additional SIP URIs may be required to allow inbound calls to numbers not associated with a
user, such as a short code. These URIs are created in the same manner as shown above with the

exception that the incoming DID number is entered directly in the Local URI, Contact, and
Display Name fields.
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5.45. SIP Line - VoIP Tab

Select the VoI P tab, to set the Voice over Internet Protocol parameters of the SIP line. Set or
verify the parameters as shown below.

For Codec Selection, select System Default from the pull-down menu to use the default
list of codecs. A list of the codecs in their current order of preference will be shown on
the right in the Selected column. To use a custom list of codecs, select Custom for
Codec Selection. Next, move unwanted codecs from the Selected column to the Unused
column. Lastly, move the codecs up or down the list in the Selected column to achieve
the desired order of preference. The example below shows the codecs used for the
compliance test. Since Cogeco only supports the G.711MU codec, this is the only codec
shown in the Selected column.

Uncheck the VolP Silence Suppression box.

If desired, direct media may be used by checking the boxes for Allow Direct Media Path
and Force direct media with phones. This will allow Avaya IP Office to redirect the
media path directly between the phones and the Avaya SBCE. Direct media cannot be
enabled if T.38 fax is also enabled on the same SIP Line.

Check the Re-invite Supported box.

Set the Fax Transport Support to T.38 Fallback. Not all media gateways in the
Cogeco network support T.38 fax. This setting will allow the fax connection to fallback
to G.711 fax if T.38 is not supported.

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

Default values may be used for all other parameters.

Click the OK button at the bottom of the page (nhot shown).

B SIP Line - Line 23 d‘v:’]l>~1|«|<|>]

SIP Line| Transport| SIP URI| YoIP T35 Fax| SIP Credentials
|:| WoIP Silence Suppression

Allows Direct Madia Path

Codec Selecti Cust 3
. = Re-invite Supported
Unused Selected
G711 ALAW B 55 G711 LILAW B4 [ Codec Lackdawn

@.729(a) 8K CS-ACELR ] PrRACE] 100kl Supported
3.723.1 6K3 MP-MLO

Force direct media with phones

&3 [J &.711 Fax ECAN
=
Fax Transport Support T35 Falback w
Location Cloud v
Call Initiation Timeout (s) |4 3
DTMF Support RFZ2833 w
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5.4.6. SIP Line — SIP Credentials
Cogeco requires that the Avaya IP Office SIP Line registers with the Cogeco SIP Trunking
Service using credentials provided by Cogeco. To configure the SIP Credentials, select the SIP
Credentials tab, then click the Add button and the New Channel area will appear at the bottom
of the pane. Configure the parameters as shown below.

e Set User Name, Authentication Name, and Contact to the pilot number provided by

Cogeco.
e Set Password to the password provided by Cogeco.

e Set Expiry (mins) to a value acceptable to Cogeco. For the compliance test, the value of
5 was used.

e Check the Registration required box.

B SIP Line - Line 23 ek -G X vl

SIP Line | Tramsport || SIP URI Yol | T35 Fax| SIP Credentials
Index  UserMame Authentication Mame  Contact Expiry (mins)  Register add. ..
Remove

Edit...

Mews SIP Credentials

User name 9055550000

Authentication Mame Q055550000

Zonkact Q055550000

Password bk

Expiry (rnins) & 3

Reqistration required
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5.5. Short Codes

ARS is used to route outbound traffic to the SIP line. A short code is used to route outbound
traffic to ARS. To create a short code, right-click on Short Code in the Navigation Pane and
select New. On the Short Code tab in the Details Pane, configure the parameters as shown
below.

¢ Inthe Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 9N;. This short code will be invoked when the user dials 9
followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.

e Setthe Line Group Id to the ARS route to be used which is defined in Section 5.6.

Click the OK button (not shown).

| IP Offices :

& BooTR(4) Shart Cade
i Operator (3)
=5y Atlantic City Code an;
w5y Syskem (1) -
17 Line (16) Feature Dial v
< Cortral Urit (3) Telephone Mumber (N
4y Extension (25)
§ User(27) Line Group ID 52: Cogeco Route 3

# Group (1)

L F 4 Short Code (64)
@B service (0] Force dccount Code [

ol RAS (1)

e Incoming Call Route (36)

Locale
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Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N;
short code except that the Telephone Number field begins with the letter W, which means
“withhold the outgoing calling line identification”.

In the case of the SIP Line to Cogeco documented in these Application Notes, when a user dials
*67 plus the number, Avaya IP Office will include the pilot number in the PAI header and will
include the Privacy: Id header. Cogeco will allow the call due to the presence of the pilot
number in the PAI header, but will prevent presentation of the caller id to the called PSTN
destination. If a long distance number is dialed, then the pilot number must have long distance
enabled or the call will fail.

*67N;: Dial i |
Short Code
Code *a7h;
Feature Dial w

Telephone Mumber W
Line Group ID 52: Cogeco Rouke w

Locale w

Force Account Code [
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5.6. ARS

ARS is used to route outbound traffic to the SIP line. To define a new ARS route, right-click
ARS in the Navigation pane and select New. In the Details pane that appears, a collection of
matching patterns (similar to short codes) can be entered to route calls as shown below.

For the compliance test, one entry was created. The entry matches on any number N and then
sends that number (N) in the SIP INVITE message on the line group defined in Section 5.4.4
(e.g., line group 23).

To create an entry, click the Add button and enter the following in the pop-up window (not
shown).
e Inthe Code field, enter the pattern to match the number passed to ARS from the short
code in Section 5.5 followed by a semi-colon.
e Set Feature to Dial. This is the action that the entry will perform.
e Set Telephone Number to N”@test.cogecodata.com”. This field is used to construct
the Request URI and To headers in the outgoing SIP INVITE message. The value N
represents the complete number passed to ARS. The domain test.cogecodata.com is the
SIP domain provided by Cogeco.
e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.4.4. This short code will use this line group when placing the
outbound call.

Click the OK button (not shown).

IP Offices E Cogeco Route -S| X vl=<]>

#- R BOOTP (4) aRS
+-¢w Operator (3)
=|-#=p Atlantic City
+-#5p System (1)
+-T7 Line (16)
+--<2» Contral Unit {3
+-4f Extension (25)
+ : User {27}
-5 Group (1)
=@ Short Code (64)

ARS Route Id [] secondary Dial tone

Route Mame Cogeco Route

Dial Delay Time System Default (47 e [ check User Call Barring

Out of Service Rouke <Manex v

@ Service (0)
ol RAS (1)
+ @ Incoming Call Route {36)
@ “WanPark (0}
s Directory (0)
f’.“ Tirme Prafile {0}
+ @ Firewall Profile (1)
+-Jfll IF Route (43
| Account Code {0}
W License (77)
i Tunnel {00
+ §} User Rights {&)
= ARS ()
S 50: Main
"¢’ 51: 5P SIP Route

In Service

l
l

Code Telephone Mumber
M; N'"@test, cogecodata.com” Dial e

Time Profile e O 0f Howrs Rouke

Feature Line Group ID

f452: Cogeco Route

<Mone = -

Remove

Edit...
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5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.4. To configure these settings, first navigate to User = Name in the
Navigation Pane where Name is the name of the user to be modified. In the example below, the
name of the user is Extn243. Select the SIP tab in the Details Pane. The values entered for the
SIP Name and Contact fields are used as the user part of the SIP URI in the From and Contact
headers for outgoing SIP trunk calls and allow matching of the SIP URI for incoming calls
without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4.4). The
example below shows the settings for user Extn243. The SIP Name and Contact are set to one
of the DID numbers assigned to the enterprise from Cogeco. The SIP Display Name (Alias)
parameter can optionally be configured with a descriptive name. If all calls involving this user
and a SIP Line should be considered private, then the Anonymous box may be checked to
withhold the user’s information from the network.

Click the OK button (not shown).

IP Offices B Extn243: 243

* ‘F EOOTP': (423) User | Voicemal | DND | Short Codes | Source Numbers || Telephony || Forwarding || Dial In || Yoice Recor
+ 47 Operataor

5 ; " ) <Ip .
2 w5y Atlankic City Menu Programming | Mobility | Group Membership | Announcements Personal Directory

=) System (1) SIP Marne 9055551236

+-F7 Line (16)

+-<2e Control Unit (3) SIF Display Mame (Alias) |Extnz43

+ -4 Extension (25)

E I Contact 9055551236

+-ipf Group (1)

+ - ShorF Code (64) ] A

{3 Service (0)
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5.8. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To
create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and
select New.

5.8.1. Incoming Call Route — Standard Tab
On the Standard tab of the Details Pane, enter the parameters as shown below.

e Set the Bearer Capacity to Any Voice.

e Setthe Line Group Id to the incoming line group of the SIP line defined in Section
5.4.4.

e Set the Incoming Number to the incoming number on which this route should match.

e Default values can be used for all other fields.

IP Offices = o

K BOOTR (4) Standard | vaice Recording | Destinations
¢ Operator (3)
(=)= Atlantic Ciky

=y Syskem (1) Bearer Capability Any Woice hd
F7 Line (16} )
<= Contral Unit {3) Uy (D & i
<@ Extension (25) Incorming Number 035551236
§ userizm
ﬂ Group {13 Incoming Sub Address
@ short Code (64)
@ Service (03 Incorning CLT
ok RAS() - o Locale A
@ Incoming Call Route (36)
€2 wanPort (0) Priarity 1-Low v
#m Direckary (0)
£ Time Prafile (0) Tag
£ Fi Il Profile {1
& @ irewiall Profile (1) Hold Music Source Syskbem Source b

B IF Route (4)
&m Account Code () Ring Tone Crwerride Tore w
W License (77)

5.8.2. Incoming Call Route — Destinations Tab

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. Click the OK button (not shown). In this example, incoming calls to
9055551236 on line 23 are routed to extension 243.

23 9055551236 el - X v =< ]=

Standard | Voice Recording | Destinations

TimeProfile Destination Fallback Extension
» Diefault Yalue 243 Extnz43 - -
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Incoming Call Routes for other direct mappings of DID numbers to Avaya IP Office users listed

in Figure 1 are omitted here, but can be configured in the same fashion.

5.9. Save Configuration
Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

3

Save Configuration

IP Ciffice Settings
Atlantic Ciky
Configuration Reboaot Mode
(%) Merge
) Immediate
) When Free

2 Timed

Reboot Time

Call Barring

[ o4 H Zancel H Help
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6. Configure Avaya Session Border Controller for Enterprise

This section describes the configuration of the Avaya SBCE. It is assumed that the initial
installation of the Avaya SBCE has been completed including the assignment of a management
IP address. The management interface must be provisioned on a different subnet than either the
Avaya SBCE private or public network interfaces (e.g., Al and B1). If the management
interface has not been configured on a separate subnet, then contact your Avaya representative
for guidance in correcting the configuration.

On all screens described in this section, it is to be assumed that parameters are left at their default
values unless specified otherwise.

6.1. Access the Management Interface

Use a web browser to access the web interface by entering the URL https://<ip-addr>, where
<ip-addr> is the management IP address assigned during installation. The Avaya SBCE login
page will appear as shown below. Log in with appropriate credentials.

AVAYA =

Password:

SeSSion BD rder Co ntrol Ier Thiz system iz restricted =olely to authorized users for legitimate
= businesz purpozes only. The actual or attempted unauthorized access,
for Enterp rlse uze or modificationz of thiz system iz strictly prohibited. Unauthorized

uzers are =ubject to company dizciplinary procedurez and or criminal
and civil penalties under state, federal or other applicable domestic and
foreign laws.

The uze of thiz =system may be monitored and recorded for
administrative and security reasons. Anyene accessing this system
exprezsly consents to zuch monitoring and recording, and is advized
that if it reveals possible evidence of criminal activity, the evidence of
zuch activity may be provided to law enforcement officials.

All usgers must comply with all corporate instructions regarding the
protection of information assets.

@ 2011 - 2013 Avaya Inc. All rights reserved.
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After logging in, the Dashboard screen will appear as shown below. All configuration screens of
the Avaya SBCE are accessed by navigating the menu tree in the left pane.

Session Border Controller for Enterprise AVAYA
Dashboard Dashboard
Admimsiraten installed Devices
Backup/Restore System Time 03:26:23 PM EDT Refresh EMS
System Management
Vi 6.2.1.Q07 i
> Global Parameters ersien GFEiE
> Global Profiles Build Date Mon Dec 9 17:33:02 CST 2013
> SIP Cluster
. Domain Policies Alams (past 24 hours) Incidents (past 24 hours)
Maone found. Maone found.

> TLS Management

> Device Specific Settings T

Mo notes found.
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6.2. Verify Network Configuration and Enable Interfaces

To view the network information provided during installation, navigate to System Management.
In the right pane, click View highlighted below.

Session Border Controller for Enterprise AVAYA

Dashboard
Administration
B

System Management

e n Devices || Updates || SSL VPN || Licensing |
> Global Parameters
> Global Profiles

> SIP Cluster

> Domain Policies

Man aln_:g:-m ent Version

Device Name
(Serial Numbar)

Status

vnj-shce?

(IFCS11010189) 10.32.101.20 6.2.1.Q07 Commissioned Reboot Shutdown Restart Application Ecllt Delete

A System Information page will appear showing the information provided during installation. In
the Appliance Name field is the name of the device (vnj-sbce2). This name will be referenced
in other configuration screens. Interfaces Al and B1 represent the private and public interfaces
of the Avaya SBCE respectively. Each interface has multiple IP addresses assigned to it. The IP
addresses used for SIP Trunking and thus applicable to this Application Note are highlighted
below. Each of these interfaces must be enabled after installation.

r General Configuration Device Configuration
Appliance Name vnj-shce2 HA Mode Mo
Box Type SIP Two Bypass Mode No
Deployment Mode  Proxy

r Network Configuration

Public IP

Metmask Gateway Interface
10.32.1258.20 10.32.128.20 2552552550 10.32.1258.254 Al
192.168.96.233 192.168.96.233 255,255 255 224 192.168.96.254 B1
10.32.128.21 10.32.128.21 255 255 2550 10.32.128.254 Al
192.168.96.234 192.168.96.234 255 255 255 224 192.168.96.254 B1

r DNS Configuration

Management IP(s)
Primary DNS 10.32.128.200 P 10.32.101.20
Secondary DNS
DMS Location Dz
DNS Client IP 10.32.128.20
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To enable the interfaces, first navigate to Device Specific Settings = Network Management in
the left pane and select the device being managed in the center pane. In the right pane, click on
the Interface Configuration tab. Verify the Administrative Status is Enabled for both the Al
and B1 interfaces. If not, click Toggle to enable the interface.

Dashboard

Administration

~

Session Border Controller for Enterprise AVAYA

Network Management: vnj-sbce2

Backup/Restore i 1
Network Configuration | | Interface Configuration |
System Management : 1
> Global Parameters vnj-sbee? Administrative Status
> Global Profiles Al Enabled Toggle
» SIP Cluster A2 Disabled Toggle
> Domain Policies
B1 Enabled Toggle
> TLS Management
4 Device Specific Settings
Network
Management
Media Interface
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6.3. Signaling Interface

A signaling interface defines an IP address, protocols and listen ports that the Avaya SBCE can
use for signaling. Create a signaling interface for both the internal and external sides of the
Avaya SBCE.

To create a new interface, navigate to Device Specific Settings = Signaling Interface in the
left pane. In the center pane, select the Avaya SBCE device (vnj-sbce2) to be managed. In the
right pane, select Add. A pop-up window (not shown) will appear requesting the name of the
new interface, followed by series of pop-up windows in which the interface parameters can be
configured. Once complete, the settings are shown in the far right pane.

For the compliance test, signaling interface Int_Sig_Intf was created for the Avaya SBCE
internal interface and signaling interface Ext_Sig_Intf was created for the Avaya SBCE external
interface. Each is highlighted below. When configuring the interfaces, configure the parameters
as follows:

e Set Name to a descriptive name.

e For the internal interface, set the Signaling IP to the IP address associated with the private
interface (Al) defined in Section 6.2. For the external interface, set the Signaling IP to the
IP address associated with the public interface (B1) defined in Section 6.2.

e In the UDP Port, TCP Port and TLS Port fields, enter the port the Avaya SBCE will listen
on for each transport protocol. For the internal interface, the Avaya SBCE was configured
to listen for UDP on port 5060. For the external interface, the Avaya SBCE was configured
to listen for UDP or TCP on port 5060. Since Cogeco uses UDP on port 5060, it would have
been sufficient to simply configure the Avaya SBCE for UDP.

Session Border Controller for Enterprise AVAYA
Dashboard Signaling Interface: vnj-sbce?2
Administration
Backup/Restore . - -
System Management Signaling Interface
> Global Parameters vnj-sbce2 Add
> Global Profiles
Signaling IP
> SIP Cluster
> Domain Policies Int_Sig_Intf 10.32.128.20 5060 — MNane Edit Delete
> TLS Management Ext_Sig_Intf 192.168.96.233 5060 5060 - Mone Edit Delete
# Device Specffic Settings Int_Sig_Intf RW  10.32.128.21 5060 —  —  None Edit Delete
Metwork Management
) Ext_Sig_Intf RW  192.168.96.234 — 5061 AvayaSBCServer Edit Delete
Media Interface
Signaling Forking
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6.4. Media Interface

A media interface defines an IP address and port range for transmitting media. Create a media
interface for both the internal and external sides of the Avaya SBCE.

To create a new interface, navigate to Device Specific Settings = Media Interface in the left
pane. In the center pane, select the Avaya SBCE device (vnj-sbce2) to be managed. In the right
pane, select Add. A pop-up window (not shown) will appear requesting the name of the new
interface, followed by series of pop-up windows in which the interface parameters can be
configured. Once complete, the settings are shown in the far right pane.

For the compliance test, media interface Int_Media_Intf was created for the Avaya SBCE
internal interface and media interface Ext_Media_Intf was created for the Avaya SBCE external
interface. Each is highlighted below. When configuring the interfaces, configure the parameters
as follows:

e Set Name to a descriptive name.

e For the internal interface, set the Media IP to the IP address associated with the private
interface (A1) defined in Section 6.2. For the external interface, set the Media IP to the IP
address associated with the public interface (B1) defined in Section 6.2.

e Set Port Range to a range of ports acceptable to both the Avaya SBCE and the far-end. For
the compliance test, the default port range was used for both interfaces.

Session Border Controller for Enterprise AVAYA
Dashboard Media Interface: vnj-sbce2
Administration
Backup/Restaore
Media Interface

System Management
. Global P t vnj-shce?

obal Farameters Modifying or deleting an existing media interface will require an application restart before taking
> Global Profiles effect. Application restarts can be issued from System Management
> SIP Cluster

> Domain Policies

Media IP Port Range
Int_Media_Intf 10.32.128.20 35000 - 40000 Edit Delete

» TLS Management

4 Device Specific Settings

Netwark Management Ext_Media_Intf 192.168.96.233 35000 - 40000 Edit Delete
Int_Media_Intf_ RW 10.32.128.21 35000 - 40000 Edit Delete
Sig Ext_Media_Intf_RW 192.168.96.234 35000 - 40000 Edit Delete
Signaling Forking
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6.5. Server Interworking

A server interworking profile defines a set of parameters that aid in interworking between the
Avaya SBCE and a connected server. Create a server interworking profile for Avaya IP Office
and the service provider SIP server. These profiles will be applied to the appropriate server in
Section 6.7.1 and 6.7.2.

To create a new profile, navigate to Global Profiles = Server Interworking in the left pane. In
the center pane, select Add. A pop-up window (not shown) will appear requesting the name of
the new profile, followed by series of pop-up windows in which the profile parameters can be
configured. Once complete, the settings are shown in the far right pane. Alternatively, a new
profile may be created by selecting an existing profile in the center pane and clicking the Clone
button in the right pane. This will create a copy of the selected profile which can then be edited
as needed. To view the settings of an existing profile, select the profile from the center pane.
The settings will appear in the right pane.

Session Border Controller for Enterprise AVAYA

Dashboard Interworking Profiles: IPOffice-T38
Administration

Add [ Rename ][ Clone ][ Delete ]

Backup/Restore
System Management ;rcrﬁ]es g Click here to add a description.

> Global Parameters 52100 General | | Timers ‘ | URI Manipulation || Header Manipulati | | Ad ed |
4 (Global Profiles ~
oo Prfles.
Fingerprint 0CS-Edge-S... Hold Support NONE
Server Interworking cisco-com 180 Handling None
Phone Interworking 181 Handling None
) ) cups
Media Forking 0CS-Frone 182 Handling Mone
. -rronten...
Routing 183 Handling None
Server Configuration IPOffice
Refer Handli M
Topology Hiding ST °
Signaling Manipulation URI Group MNone
SP-General
URI Groups 3¢ Handling Mo
. SP-G I-T38
SIP Cluster enera Diversion Header Support Mo
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6.5.1. Server Interworking — Avaya IP Office

For the compliance test, server interworking profile IPOffice-T38 was created for Avaya IP
Office by creating a new profile and accepting the default values for all settings with the
exception of setting the T.38 Support to Yes. The General tab parameters are shown below.

General ‘ | Timers ‘ ‘ URI Manipulation ‘ | Header Manipulation ‘ ‘ Advanced |

General

Hold Suppaort NOME
180 Handling None
181 Handling MNone
182 Handling None
183 Handling MNone
Refer Handling Mo
URI Group None
3xx¢ Handling No
Diversion Header Support No
Delayed SDP Handling Mo
Re-Invite Handling No
T.38 Support Yes
URI Scheme SIP
Via Header Format RFC3261

L

Scroll down to see the rest of the General tab.

Privacy Enabled
User Name
P-Asserted-ldentity
P-Preferred-ldentity

Privacy Header

DTMF Support

DTMF

None

Edit

<

The Timers, URI Manipulation, Header Manipulation tabs have no entries.
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The Advanced tab parameters are shown below.

General ‘ ‘ Timers ‘ ‘ URI Manipulation ‘ ‘ Header Manipulation Advanced

Record Routes Both
Topology Hiding: Change Call-D Yes
Call-Info NAT Mo

Change Max Forwards Yes

Include End Point IP for Context Lookup Mo

0OCS Extensions Mo
AVAYA Extensions Mo
MNORTEL Extensions Mo
Diversion Manipulation Mo
Metaswitch Extensions Mo
Reset on Talk Spurt Mo

Reset SRTP Context on Session Refresh  No

Has Remote SBC Yes
Route Response on Via Port Mo
Cisco Extensions Mo

6.5.2. Server Interworking — Cogeco

For the compliance test, server interworking profile SP-General-T38 was created for the Cogeco
SIP server. When creating the profile, the default values were used for all parameters with the
exception of T.38 Support set to Yes. Thus, the SP-General-T38 profile is identical to the
IPOffice-T38 profile created in Section 6.5.1.
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6.6. Signaling Manipulation

Signaling manipulation scripts provides for the manipulation of SIP messages which cannot be
done by other configuration within the Avaya SBCE. It was necessary to create a signaling
manipulation script that will be applied to the Cogeco SIP server in Section 6.7.2. The details of
the script are shown in Section 6.6.1.

To create a script, navigate to Global Profiles = Signalling Manipulation in the left pane. In
the center pane, select Add. An edit window (not shown) will appear in which a title for the
script can be entered as well as the script itself. Once complete, click Save to save the new
script. Alternatively, a new script may be created by selecting an existing script in the center
pane and clicking the Clone button in the right pane. This will create a copy of the selected
script which can then be edited as needed. To view an existing script, select the script from the
center pane. The script will appear in the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Signaling Manipulation Scripts: CogecoHdrManip
Administration [ Download H Clone ” Delete ]
Backup/Restore
Signaling i i

> Global Parameters FErE Signaling Manipulation |
4 Global Profiles SR RED= //Remove Remote Address header in outbound INVITE and 288 OK =

Domain DoS ; :

. i PraviderWithReg within session "ALL"

Fingerprint

Server Interworking CogecoHdri... act on message where ¥DIRECTION="OUTBOUND" and ¥ENTRY POINT="POST ROUTING"

Phone Interworking remove (¥HEADERS[ "Remote-Address"][1]);

Media Forking } }

Routing //Change Contact header in Register Message to external IP

Server Configuration

- within session "REGISTER"
Topology Hiding {
Signaling act on message where ¥DIRECTION="OUTBOUND" and XENTRY_POINT="POST_ROUTING"
. . {
Manipulation _ XHEADERS["Contact”][1].URI.HOST = "135.18.96.233";
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6.6.1. Signaling Manipulation Script — Cogeco

A signaling manipulation script named CogecoHdrManip was created for Cogeco that performs
three manipulations represented by three code segments highlighted in the screenshots below.

The first manipulation removes the Remote Address header from all outbound messages from
the Avaya SBCE to Cogeco. It is removed because it is not used by the service provider and it
contains an internal enterprise IP address which should not be shared outside the enterprise.

The second manipulation changes the host part of the Contact header of the Register message
send from the Avaya SBCE to Cogeco. It was modified to use the external IP address of the
Avaya SBCE instead of the internal address.

Signaling Manipulation

//Remove Remote Address header in cutbound INVITE and 288 QK
within session "ALL"
1

act on message where ¥DIRECTION="OUTBOUND" and ¥ENTRY_POINT="POST_ROUTING" 1

1
remove (¥HEADERS[ "Remote-Address™][1]);

b
}

/fChange Contact header in Register Message to external IP

within session "REGISTER"
! 2
act on message where ¥DIRECTION="OUTBOUND" and ¥ENTRY_POINT="POST_ROUTING"

1
¥HEADERS["Contact™][1].URI.HOST = "192.168.96.233";
b

¥

/f In the case of call fwd/twinning, replace PAI hdr with
// From hdr so calling party number is correct.
// Call fwd/twinning is determined by the presence of the Diversicn header
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Lastly, the third manipulation modifies the P-Asserted-Identity (PAI) header in the case of call
forwarding and twinning so that the calling party displayed at the far-end is the original PSTN
caller instead of the Cogeco pilot number. The script first determines if call forwarding or
twinning is in progress by the presence of the Diversion header in the outbound message. If the
Diversion header is present, then the script overwrites the calling party information in the PAI
header with the calling party information from the From header.

Signaling Manipulation

i ~
¥HEADERS["Contact™][1].URI.HOST = "192.168.96.233";
b
h
/S In the case of call fwd/twinning, replace PAI hdr with
/f From hdr so calling party number is correct.
// Call fwd/twinning is determined by the presence of the Diversion header
within session "INVITE"
1
act on request where ¥DIRECTION="OQUTBOUND" and XENTRY_POINT="POST_ROUTING"
1
if (exists(¥HEADERS["Diversion™][1])) then 3
1
Hvarl = ¥HEADERS["From"][1].URI.USER;
¥var2 = ¥HEADERS["From"][1].DISPLAY NAME;
EHEADERS["P-Asserted-Identity"][1].URI.USER = &varl;
EHEADERS["P-Asserted-Identity™ ][1].DISPLAY _NAME = Hwvarl;
h
b
b
Edit w
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6.7. Server Configuration

A server configuration profile defines the attributes of the physical server. Create a server
configuration profile for Avaya IP Office and the service provider SIP server.

To create a new profile, navigate to Global Profiles = Server Configuration in the left pane.
In the center pane, select Add. A pop-up window (not shown) will appear requesting the name
of the new profile, followed by series of pop-up windows in which the profile parameters can be
configured. Once complete, the settings are shown in the far right pane. To view the settings of
an existing profile, select the profile from the center pane. The settings will appear in the right
pane.

Session Border Controller for Enterprise AVAYA

Dashboard Server Configuration

Administration Add

Backup/Restore

Server Profiles -
System Management ! Use the add button to create a new Server Configuration profile.
> Global Parameters Mo entries

found.

4 (Global Profiles

Domain DoS

Fingerprint

Server Interworking

Phone Interworking

Media Forking

Routing

Topology Hiding
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6.7.1. Server Configuration — Avaya IP Office

For the compliance test, server configuration profile IPO-ACity was created for Avaya IP
Office. When creating the profile, configure the General tab parameters as follows:

e Set Server Type to Call Server.

e Set IP Addresses / FQDNSs to the IP address of the Avaya IP Office signaling interface.

e Set Supported Transports to the transport protocol(s) that can be used for SIP signaling by
Avaya IP Office.

e Set the UDP Port and TCP Port to the ports Avaya IP Office will listen on for SIP requests.
The standard SIP UDP/TCP port is 5060.

[ Rename H Clone H Delete ]
General || Authentication | ‘ Heartbeat | | Advanced |
Server Type Call Server
IP Addresses / FQDNs 10.32.128.25
Supported Transports TCP, UDP
TCP Port 5060
UDP Port 5060

On the Advanced tab, set the Interworking Profile field to the interworking profile for Avaya
IP Office defined in Section 6.5.1.

Rename H Clone ” Delete l
General ‘ | Authentication ‘ | Heartbeat Advanced
Enable Do5 Protection |
Enable Grooming FI
Interwarking Profile IPOffice-T38
Signaling Manipulation Script MNane
TCP Connection Type SUBID
UDP Connection Type SUBID
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6.7.2. Server Configuration — Cogeco

For the compliance test, server configuration profile Cogeco was created for Cogeco. When
creating the profile, configure the General tab parameters as follows:

e Set Server Type to Trunk Server.

e Set IP Addresses / FQDNSs to the IP address of the Cogeco SIP server.

e Set Supported Transports to the transport protocol(s) that can be used for SIP signaling by
Cogeco.

e Set the UDP Port to the port Cogeco will listen on for SIP requests. The standard SIP UDP
port is 5060.

[ Rename ][ Clone H Delete ]

General Authentication H Heartheat | ‘ Advanced |
Server Type Trunk Server
IP Addresses / FQDMNs 192.168.189.168
Supported Transports UDP
UDP Port 5060

On the Advanced tab, set the Interworking Profile field to the interworking profile for Cogeco
defined in Section 6.5.2. Set the Signaling Manipulation Script to the SIP manipulation script
created in Section 6.6.1.

[ Rename l [ Clone ] [ Delete ]

General ‘ | Authentication || Heartbeat Advanced
Enable DoS Protection F
Enable Grooming [F]
Interwarking Profile SP-General-T38
Signaling Manipulation Script CogecoHdrManip
UDP Connection Type SUBID
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6.8. Application Rules

An application rule defines the allowable SIP applications and associated parameters. An
application rule is one component of the larger endpoint policy group defined in Section 6.11.
For the compliance test, the predefined default-trunk application rule (shown below) was used
for both Avaya IP Office and the Cogeco SIP server.

To view an existing rule, navigate to Domain Policies = Application Rules in the left pane. In
the center pane, select the rule (e.g., default-trunk) to be viewed.

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> SIP Cluster

4 Domain Palicies
Application Rules
Border Rules
Media Rules
Security Rules
Signaling Rules
Time of Day Rules
End Point Policy

Session Border Controller for Enterprise AVAYA

Application Rules: default-trunk

Add

Application
Rules
default

default-trunk

|Fi\terBy Device... V|

Maximum Concurrent  Maximum Sessions

oL Sessions Per Endpoint
Voice 2000 2000
Video [T
M [

Miscellaneous

CDR Support Mone

RTCF Keep-Alive Mo
Groups
Session Policies
> TLS Management
CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 46 of 63

SPOC 6/10/2014

©2014 Avaya Inc. All Rights Reserved. CogecolPO9SBCE




6.9. Media Rules

A media rule defines the processing to be applied to the selected media. A media rule is one
component of the larger endpoint policy group defined in Section 6.11. For the compliance test,
the predefined default-low-med media rule (shown below) was used for both Avaya IP Office
and the Cogeco SIP server.

To view an existing rule, navigate to Domain Policies = Media Rules in the left pane. In the
center pane, select the rule (e.g., default-low-med) to be viewed.

Each of the tabs of the default-low-med media rule containing data is shown below.

The Media NAT tab has no entries.

Session Border Controller for Enterprise AVAYA
Dashboard Media Rules: default-low-med

Administration |Filter By Davice... v
Backup/Restore

Media Rules It is not recommended to edit the defaults. Try cloning or adding a new rule instead.

System Management

default-low-med
> Global Parameters Media NAT ‘ | Media Encryption ‘ | Media Anomaly | | Media Silencing ‘ | Media QoS |
» Global Profiles default-low-med-enc
- SIP Cluster default-high Media NAT Learn Media IP dynamically
4 Domain Policies
i default-high-enc
Application Rules

Border Rules avaya-low-med-enc

The Media Encryption tab indicates that no encryption was used.

Media NAT | | Media Encryption | Media Anomaly | | Media Silencing | | Media QoS |

Audio Encryption
Preferred Formats RTP

Interworking

Preferred Formats RTP

Interworking

Capahility Megotiation O
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The Media Anomaly tab shows Media Anomaly Detection was disabled.

Media NAT | | Media Encryption | ‘ Media Anomaly | | Media Silencing | | Media QoS

Media Anomaly Detection [

The Media Silencing tab has no entries.

The Media QoS settings are shown below.

Media NAT | | Media Encryption | | Media Anomaly | | Media Silencing Media QoS
Media QoS Reporting
RTCP Enabled O
Media QoS Marking
Enabled
QoS Type DSCP
Audio QoS
Audio DSCP EF
Video Qo5
Video DSCP EF
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6.10. Signaling Rules

A signaling rule defines the processing to be applied to the selected signaling traffic. A signaling
rule is one component of the larger endpoint policy group defined in Section 6.11. For the
compliance test, the predefined default signaling rule (shown below) was used for both Avaya

IP Office and the Cogeco SIP server.

To view an existing rule, navigate to Domain Policies = Signaling Rules in the left pane. In

the center pane, select the rule (e.g., default) to be viewed.

The General tab settings are shown below.

Session Border Controller for Enterprise

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> 3IP Cluster

4 Domain Policies
Application Rules
Border Rules
Media Rules
Security Rules
Signaling Rules
Time of Day Rules

End Point Policy
Groups

Session Policies
> TLS Management
> Device Specific Settings

Signaling Rules: default

Add |Fi|ter By Device V|

Signaling Rules

It is not recommended to edit the defaults. Try cloning or adding a new rule instead.

AVAYA

Clone

default

General”"1 ||" p

B Head: R Head,
q 4 P J

Signaling QoS | uciD |

No-Content-Typ.

Requests
Non-2XX Final Responses
Optional Request Headers

Optional Response Headers

Requests
Non-2XX Final Responses
Optional Request Headers

Optional Response Headers

Enable Content-Type Checks

Action Allow

Exception List

Allow
Allow
Allow
Allow

Allow
Allow
Allow

Allow

Content-Type Paolicy

Multipart Action Allow

Exception List

The Requests, Responses, Request Headers, Response Headers and UCID tabs have no
entries. The Signaling QoS tab is shown below.

General | ‘ Requests || Responses ‘ | Request Headers ‘ | Response Headers | Signaling QoS ‘ uciD ‘

Signaling QoS
QoS Type
DSCP

DSCP
AF41
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6.11. Endpoint Policy Groups

An endpoint policy group is a set of policies that will be applied to traffic between the Avaya
SBCE and a signaling endpoint (connected server). Thus, an endpoint policy group must be
created for Avaya IP Office and the service provider SIP server. The endpoint policy group is
applied to the traffic as part of the endpoint flow defined in Section 6.14.

To create a new group, navigate to Domain Policies = End Point Policy Groups in the left
pane. In the center pane, select Add. A pop-up window (not shown) will appear requesting the
name of the new group, followed by series of pop-up windows in which the group parameters
can be configured. Once complete, the settings are shown in the far right pane. To view the
settings of an existing group, select the group from the center pane. The settings will appear in
the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Policy Groups: default-low
Administration Add \ Filter By Device.. v ‘
Backup/Restore
Policy G 5 iz e ende: adit the de S. & instead.
System Management It is not recommended to edit the defaults. Try adding a new group instead
default-low
> Global Profiles default-low-enc
Policy Group
> SIP Cluster default-med
<« Domain Policies -S -Add
default-med-enc —
Application Rules ) Order  Application  Border Media Security  Signaling  Time of Day
Border Rules GRS defaultlow
-I default default 0 default-low  default default Edit  Clone
Media Rules default-high-enc -med
Security Rules

QCS-default-high
Signaling Rules

. -def-low-e...
Time of Day Rules avaya-cerione

End Point Policy
Groups

6.11.1. Endpoint Policy Group — Avaya IP Office

For the compliance test, endpoint policy group IPO-EP-Policy was created for Avaya IP Office.
Default values were used for each of the rules which comprise the group with the exception of
Application. For Application, enter the application rule referenced in Section 6.8. The details
of the default settings for Media and Signaling are showed in Section 6.9 and Section 6.10
respectively.

Policy Group

Summary ][ Add ]

Order  Application Border Media Security Signaling  Time of Day

default- default-low . e
trunk default -med default-low  default default Edit Clane
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6.11.2. Endpoint Policy Group — Cogeco

For the compliance test, endpoint policy group SP-EP-Policy was created for the Cogeco SIP
server. Default values were used for each of the rules which comprise the group with the
exception of Application. For Application, enter the application rule referenced in Section 6.8.
Thus, the SP-EP-Policy is identical to the IPO-EP-Policy created in Section 6.11.1.

6.12. Routing

A routing profile defines where traffic will be directed based on the contents of the URI. A
routing profile is applied only after the traffic has matched an endpoint server flow defined in
Section 6.14. Create a routing profile for Avaya IP Office and the service provider SIP server.

To create a new profile, navigate to Global Profiles 2 Routing in the left pane. In the center
pane, select Add. A pop-up window (not shown) will appear requesting the name of the new
profile, followed by series of pop-up windows in which the profile parameters can be configured.
Once complete, the settings are shown in the far right pane. To view the settings of an existing
profile, select the profile from the center pane. The settings will appear in the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Routing Profiles: default

Administration Add
Backup/Restore

System Management It 1s not recommended to edit the defaults. Try cloning or adding a new profile instead.

» Global Parameters default Routing Profile

4 (Global Profiles

Add

Domain DoS
Fingerprint Priority URI Group Mext Hop Server 1 Next Hop Server 2
Server Interworking 1 * View Edit

Phone Interwarking
Media Forking

Routing

Server Configuration
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6.12.1. Routing — Avaya IP Office

For the compliance test, routing profile To-1PO-ACity was created for Avaya IP Office. When
creating the profile, configure the parameters as follows:

e Set the URI Group to the wild card * to match on any URI.

e Set the Next Hop Server 1 field to the IP address of Avaya IP Office signaling interface.
e Enable Next Hop Priority.

e Set the Outgoing Transport field to UDP. This is the transport protocol the Avaya SBCE
will use to send SIP messages to the Avaya IP Office.

View Routing Rule X

Priority 1
URI Group *
Mext Hop Server 1 10.32.128.25

MNext Hop Server 2

Mext Hop Priority
NAPTR Fi
SRV O
Mext Hop in Dialog ]
Ignore Route Header F
Outgoing Transport UDP
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6.12.2. Routing — Cogeco

For the compliance test, routing profile To-Cogeco was created for Cogeco. When creating the
profile, configure the parameters as follows:

e Set the URI Group to the wild card * to match on any URI.
e Set the Next Hop Server 1 field to the IP address of the Cogeco SIP server.
e Enable Next Hop Priority.

e Set the Outgoing Transport field to UDP as defined by Cogeco. This is the transport
protocol the Avaya SBCE will use to send SIP messages to the Cogeco.

View Routing Rule X

Priority 1
URI Group *
Mext Hop Server 1 192.168.189.168

MNext Hop Server 2

Mext Hop Priarity
MNAPTR Fi
SRV F
Mext Hop in Dialog L
lgnore Route Header F
Cutgoing Transport UDP
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6.13. Topology Hiding

Topology hiding allows the host part of some SIP message headers to be modified in order to
prevent private network information from being propagated to the untrusted public network. It
can also be used as an interoperability tool to adapt the host portion of these same headers to
meet the requirements of the connected servers. The topology hiding profile is applied as part of
the endpoint flow in Section 6.14. For the compliance test, the predefined default topology
hiding profile (shown below) was used for Avaya IP Office and a separate profile was created for
the Cogeco SIP server.

To add a new profile or view an existing profile, navigate to Global Profiles - Topology
Hiding in the left pane. In the center pane, select Add to add a new profile. In the center pane,
select an existing profile (e.g., default) to be viewed.

Session Border Controller for Enterprise AVAYA
Dashboard Topology Hiding Profiles: default
Administration Add
Backup/Restore
Topol Hidi i i i i [
System Management C'pC;DCE%"EEI ing It is not recommended to edit the defaults. Try cloning or adding a new profile instead.
> Global Parameters default Topology Hiding
4 Global Profiles
; cisco_th_profile Header Criteria Replace Action Overwrite Value
Domain DoS - - )
Fingerprint JC-FaxTH Referred-By IP/Domain Auto
Server Interworking JCVoiceTH Request-Line IP/Domain Auto
. ; )
Phohe Intew;orkmg Cogeco-TH To IP/Domain Auto
Media Forking SDP IP/Domain Auto
Routing Record-Route IP/Domain Auto
Server Configuration
; From IP/Domain Auto
gy g _
Signaling Manipulation Via IP/Damain Auto
URI Groups Refer-To IP/Domain Auto
> SIP Cluster
Edit
> Domain Policies
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6.13.1. Topology Hiding — Cogeco

The topology hiding profile Cogeco-TH was created for the Cogeco SIP server. Since the
service provider domain is configured on Avaya IP Office, Avaya IP Office is already sending
the domain in most headers. Thus, the Avaya SBCE does not need to change the headers where
the domain is present. As a result, the profile Cogeco-TH has the Criteria set to IP only. In
addition, Avaya IP Office sends the IP address instead of the domain in the From header of the
OPTIONS message. Thus, the topology hiding profile was used to overwrite the IP address in
the From header of all messages to the Cogeco domain.

Topology Hiding
Criteria Replace Action Overwrite Value
Referred-By P Auto
Request-Line P Auto
To P Auto
SDP IP Auto
Record-Route P Auto
From P Owverwrite test.cogecodata.com
Via P Auto
Refer-To IP Auto
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6.14. End Point Flows

Endpoint flows are used to determine the signaling endpoints involved in a call in order to apply
the appropriate policies. When a packet arrives at the Avaya SBCE, the content of the packet (IP
addresses, URIs, etc) is used to determine which flow it matches. Once the flow is determined,
the flow points to policies and profiles which control processing, privileges, authentication,
routing, etc. Once routing is applied and the destination endpoint is determined, the policies for
the destination endpoint are applied. Thus, two flows are involved in every call: the source
endpoint flow and the destination endpoint flow. In the case of the compliance test, the signaling
endpoints are Avaya IP Office and the service provider SIP server.

To create a new flow for a server endpoint, navigate to Device Specific Settings = End Point
Flows in the left pane. In the center pane, select the Avaya SBCE device (vnj-shce2) to be
managed. In the right pane, select the Server Flows tab and click the Add button. A pop-up
window (not shown) will appear requesting the name of the new flow and the flow parameters.
Once complete, the settings are shown in the far right pane.

Session Border Controller for Enterprise AVAYA
Dashboard End Point Flows: vnj-sbce2

Administration

Backup/Restore

Subscriber Flows | Server Flows

vnj-shce2 Add

System Management

> Global Parameters

> Global Profiles
. SIP Cluster Use the add button to create a new Server Flow.

> Domain Policies

> TLS Management

4 Device Specific Settings
Metwork Management
Media Interface
Signaling Interface
Signaling Forking
End Point Flows

Session Flows
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6.14.1. End Point Flow — Avaya IP Office

For the compliance test, endpoint flow IPO-ACity was created for Avaya IP Office. All traffic
from Avaya IP Office will match this flow as the source flow and use the specified Routing
Profile To-Trunks to determine the destination server and corresponding destination flow. The
End Point Policy and Topology Hiding Profile will be applied as appropriate. When creating
the flow, configure the parameters as follows:

For the Flow Name, enter a descriptive name.

For Server Configuration, select the Avaya IP Office server created in Section 6.7.1.
To match all traffic, set the URI Group, Transport, and Remote Subnet to *.

Set the Received Interface to the external signaling interface.

Set the Signaling Interface to the internal signaling interface.

Set the Media Interface to the internal media interface.

Set the End Point Policy Group to the endpoint policy group defined for Avaya IP
Office in Section 6.11.1.

Set the Routing Profile to the routing profile defined in Section 6.12.2 used to direct
traffic to the Cogeco SIP server.

Set the Topology Hiding Profile to the topology hiding profile defined for Avaya IP
Office in Section 6.13.

View Flow: IPO-ACity X

r Criteria r Profile
Flow Mame [PO-ACity Signaling Interface Int_Sig_Intf
Server Configuration  IPO-ACity Media Interface Int_Media_Intf
URI Group * End Point Policy Group  IPO-EP-Policy
Transport * Routing Profile To-Cogeco
Remote Subnet * Topology Hiding Profile  default
Received Interface Ext Sig_Intf File Transfer Profile MNone
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6.14.2. End Point Flow — Cogeco

For the compliance test, endpoint flow Cogeco was created for the Cogeco SIP server. All
traffic from Cogeco will match this flow as the source flow and use the specified Routing
Profile To-IPO-ACity to determine the destination server and corresponding destination flow.
The End Point Policy and Topology Hiding Profile will be applied as appropriate. When
creating the flow, configure the parameters as follows:

For the Flow Name, enter a descriptive name.

For Server Configuration, select the Cogeco SIP server created in Section 6.7.2.

To match all traffic, set the URI Group, Transport, and Remote Subnet to *.

Set the Received Interface to the internal signaling interface.

Set the Signaling Interface to the external signaling interface.

Set the Media Interface to the external media interface.

Set the End Point Policy Group to the endpoint policy group defined for Cogeco in
Section 6.11.2.

Set the Routing Profile to the routing profile defined in Section 6.12.1 used to direct
traffic to Avaya IP Office.

Set the Topology Hiding Profile to the topology hiding profile defined for Cogeco in
Section 6.13.1.

View Flow: Cogeco X

r Criteria r Profile
Flow Mame Cogeco Signaling Interface Ext Sig_Intf
Server Configuration Cogeco Media Interface Ext Media_Intf
URI Group * End Point Policy Group  SP-EP-Policy
Transport * Routing Profile To-IPO-ACity
Remote Subnet * Topology Hiding Profile . Cogeco-TH
Received Interface Int_Sig_Intf File Transfer Profile MNone
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7. Cogeco SIP Trunking Configuration

Cogeco is responsible for the configuration of the Cogeco SIP Trunking Service. The customer
will need to provide the IP address used to reach the Avaya IP Office at the enterprise. In the
case of the compliance test, this is the Avaya SBCE public address. Cogeco will provide the
customer the necessary information to configure the Avaya IP Office and Avaya SBCE
including:

e [P address of the Cogeco SIP proxy
e SIP Credentials — user name and password
e Pilot number and DID numbers

8. Verification Steps

This section provides verification steps that may be performed in the field to verify that the
solution is configured properly.

8.1. System Status

The System Status application is used to monitor and troubleshoot Avaya IP Office. Use the
System Status application to verify the state of the SIP trunk. System Status can be accessed
from Start = Programs => IP Office = System Status.

The following screen shows an example Logon screen. Enter the Avaya IP Office IP address in
the Control Unit IP Address field, and enter an appropriate User Name and Password. Click
Logon.

LJ | Avaya IP Office System Status

AVAyA IP Office System Status S

Help Exit  About

Online | Sffline

Logon
Control Unit IP Address: iRk bl
Services Base TCP Port: palhif

AR e Administrator

Password:

Auto reconnect
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

IP Office System Status

Help Snapshot  LogOff  Exit  Abaout

Status ion Summary Alarms

SIP Trunk Summary

Peer Domain Mame: test.cogecodata.com

Resolved Address: 10,32.1258.20

Line Mumber: 23

Mumber of Administered Channels: 10

Murnber of Channels in Use: a

Administered Compression: G711 Mu

Silence Suppression: Off

Laver 4 Prokocol: UDF

SIP Trunk Channel Licenses: Unlimited . %
SIP Trunk Channel Licenses in Use: i}

SIP Device Features:

Call  Current Timein Remote  Co... ooa r et Party  Directi... Round
Ref State  State  Media &... dia,.. onC Trip D... Jitked

OF Errar
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8.2. Monitor

The Monitor application can also be used to monitor and troubleshoot Avaya IP Office. Monitor
can be accessed from Start = Programs = IP Office = Monitor. The application allows the
monitored information to be customized. To customize, select Filters - Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this
example, all SIP settings are checked.

" All Settings )

T1 | VPN | WAN | 5EN | Jade
&TM | cal | DTE | EConf | FrameRelay | GOD | H323 | Interface
1SDN ] Ke_l,l.-"Lamp] Directory ] Media ] FPF ] Rz ] Houting] Services  SIF l System

Events

W Sip |Vebose - v STUN v SIP Dect
Packets
[v¥ SIP Reg/Opt Rz [v SIP Mizc Rx
v SIP FReg/Opt Tx v SIP Misc Tx
[v¥ SIPCallRx [v Crm Matify Rx
[v SIPCall T [v Crmn Motify T
I¥ SipR« IP Filter [rn.nnin. nini.ninn)
IV SipTx |

Deraulmu| Clear All | TabEIearAII| Tab SetAII| el

Save File | Load File | Load Partial File| Select File |

9. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office 9.0
and the Avaya Session Border Controller for Enterprise 6.2 to the Cogeco SIP Trunking Service.
The Cogeco SIP Trunking Service is a SIP-based Voice over IP solution for customers ranging
from small businesses to large enterprises. It provides a flexible, cost-saving alternative to
traditional hardwired telephony trunks. The Cogeco SIP Trunking Service passed compliance
testing. Please refer to Section 2.2 for any exceptions.
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10. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com.

[1] IP Office 9.0 IP500/1P500 V2 Installation, Document Number 15-601042, Issue 28p, March
26, 2014.

[2] IP Office Release 9.0 Manager, Document Number 15-601011, Issue 9.02.0, January 6,
2014.

[3] Using System Status, Document Number 15-601758, Issue 09c, August 15, 2013.

[4] IP Office Release 9.0 Administering Voicemail Pro, Document Number 15-601063, Issue
9.01.0, September 13, 2013.

[5] Using IP Office System Monitor, Document Number 15-601019, Issue 05e, February 5, 2014.

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 63 of 63
SPOC 6/10/2014 ©2014 Avaya Inc. All Rights Reserved. CogecolPO9SBCE


mailto:devconnect@avaya.com

